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Getting Started with the CVT-EGM
This document is designed to help you get started with the CVT for the EGM (CVT).

CVT-EGM Introduction

The goal of the CVT-EGM product is to provide an automated tool that provides a consistent set of test
cases, which are approved by GSA for testing the G2S functionality in a G2S EGM. A tester configures the
tests to be run, and then tells the CVT-EGM to initiate a G2S conversation with the EGM under test and
automatically run through the selected test cases. If a manual action by the tester is required by a test
case, the program pauses and instructions are displayed to the tester. At the conclusion of each test
session, a set of reports can be created, which provide complete details of the results of the test session.

The following concepts are important to understand when using the CVT-EGM:

Test Session Template — The Test Session Template is used to define the specific set of classes,
functional groups, and test cases to include in a test. This template is then applied against the EGM
Survey to remove any undesired G2S Classes, Functional Groups, or test cases.

As an example, a test session template would be useful when doing repeated tests of the Core
functionality of the Communications class, when you don’t want to revoke the EGM’s certificate on
every test run. In this case, the Test Session Template would include all test cases in the Core
Communications class, except for CM-COR-00089.
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Installing the CVT

The CVT installer, documentation, and all other supplemental materials can be found on the CVT
Development Portal on the RadBlue web-site. The CVT installer requires a 64-bit Windows operating
system and a current CVT license.

Once you've downloaded the installer, just run the installer program, providing a license when
prompted. The installer program will install both CVT programs — one for testing the EGM, and a second
for testing the Host, the former being the focus of this getting started guide.

If you have any questions or issues, just let us know via support@radblue.com.

Starting the CVT

When you installed the CVT, a RadBlue CVT for the EGM Icon was created on the desktop. Double-click
that Icon to start the tool. When the tool starts for the first time, and you are presented with the
following display. You will need to select the appropriate IP address for your test network.

CVT for the EGM - m} X
File - Tools = Help ~ CVT ?m
4 VT
’ Test Session Engine (=1l
How it Works Host Address Selector
. - Select IP Address : | 192,168.100.59
Before you start using the CVT. vou must configure communications. N
You can change these settings at any time through Tools = Configure > Engine > Transport. OK
Select the TP address that the EGM will use to communicate with the CVT.
Once you've completed the initial setup, click OK to go to the main screen.
<All EGMs> w ,ﬁ Compare @ Options ~ x Clear -~ Show Event Report Realtime Update
Type here to fiter G25 Transcript
Date Received Message ID ! From Location To Location Session Type Session ID Command ID Device Summary Comment

[m°1] Test Session Engine | [8°] Test Sessions History | (8- Debug Console

Confidential — Radical Blue Gaming, Inc. Page 2


http://www.radblue.com/cvtportal/
http://www.radblue.com/cvtportal/
mailto:support@radblue.com

radblue Getting Started with CVT-EGM

Once the host IP address has been configured the CVT will display the list of EGMs that are connected to
the CVT in the opening display. Until the first EGM connects the display will be as follows:

€4 CVT for the EGM

- O X
File~ Tools~ Help ~ CcvT E‘m
4 CvT
’ Test Session Engine (L e
HostURL : hitp://192.168.100.59:47101
HostID: 17
We're waiting for EGMs to connect to the CVT...
<Al EGMs = w h’f]l Compare Options + ¢ Clear ~ Show Event Report  [/] Realtime Update
Type here to filter G25 Transcript
Date Received Message ID ~ ! From Location To Location Session Type Session 1D Command ID Device Summary Comment

|m°1| Test Session Engine | (7] Test Sessions History | [8°1 Debug Console

Configuring your EGM

You will need to configure your EGM to have a host that is specified in the Host URL and Host ID as
displayed on the opening screen.
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Selecting your EGM

Once you have configure your EGM and it is connected to the CVT you will see the EGM in the list of

known EGM. By double-clicking the EGM you will be selecting the EGM for CVT testing.

€4 CVT for the EGM —

File - Tools - Help ~ CVT
4 VT
» Test Session Engine o 8 X
To start a test session, select an EGM from the list of connected EGMs, and right click Test EGM (or double-click the row).
status | EGM ID Last Test Session ID | Last Tested On | EGM Location
@ RBG_12345573 12 2016-01-07T12:37:34,351-08:00 http://127.0.0.1: 38 102/RST /api-services/G25APT
<Al EGMs > ~ ﬁﬂ Compare IE] Options = X Clear = Show Event Report  [/] Realtime Update
Type here to filter G25 Transcript
Date Received Message ID  ~ ! From Location To Location Session Type Session ID Command ID Device Summary Comment
2015-01-08T08:... 5508 RBG_12345673 Host ID 17 NfA a a unknown[0] GZSACK A
2015-01-08T08:... 5507 HostID 17 RBG_12345678 G25_response 4000002 2 communications[... communications....
. 5508 HostID 17 RBG_12345678 MfA 0 0 unknown[0] G2SACK
. 9305 RBG_12345678 Host ID 17 G25_request 4000002 6926 communications[... communications....
. 5504 RBG_12345673 Host ID 17 MNfA 0 0 unknown[0] G2SACK
. 5503 HostID 17 RBG_12345678  G2S_response 4000001 1 communications[... communications....
. 5501 RBG_12345673 Host ID 17 G25_response [u] 1 communications[... communications....
. 5499 HostID 17 RBG_12345678 G25_request 0 1 communications[... communications....
2015-01-08T08:... 5498 HostID 17 RBG_12345673 NfA a a unknown[0] GZSACK
INAAN1NRTNR . Caa7 DR 172340573 Hoet TN 17 LIS _ranuact Annnnn g A/O7E rornLIns i L rornL IR v

Iﬂ Test Session Engine Iﬂ Test Sessions History Iﬂ Debug Console
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Starting a CVT Test Session

Getting Started with CVT-EGM

When starting a CVT test session, you are presented with the following display:

@4 CVT forthe EGM

File = Tools = Help -
4 CvT

» Test Session Engine

vt B

@‘3 Start s:_-' Stop O Configure Test Session % Change EGM
Test Session Detail
Test Session|D: Test Session Template :
Test CaselD: Device 1D :
Description :
Step D :
Description :
CVT Error Results
Test Case ID Step ID Message ID ~1 Device Class Device ID Error Code Error Text
<All EGMs > ~ ,ﬂ Compare IE] Options = x Clear ~ Show Event Report Realtime Update
Type here to filter G25 Transcript
Date Received Message I ! From Location To Location Session Type Session 1D Command ID Device Summary Comment
2016-01-08T08:... 5780 RBG_12345673 HostID 17 MN/A a a unknown[0] G2SACK A
2016-01-08T08... 5779 Host 1D 17 RBG_12345678 G25_response 4000020 70 employee[1] employee.erro...
2016-01-08T08:... 5778 HostID 17 REG_12345678 M/A a 0 unknown[] G2SACK
2016-01-08T08:... 5777 RBG_12345678 HostID 17 G25_request 4000020 6994 employee[1] employee.getEm...
2016-01-08T08:... 5776 RBG_12345678 HostID 17 MfA a 0 urknown[] G25ACK
2016-01-08T08:... 5775 Host ID 17 RBG_12345673 G25_response 4000019 69 eventHandler[17] eventHandler.ev...
2016-01-08T08:... 5774 HostID 17 RBG_12345673 MfA 0 a unknown[0] G2SACK
2016-01-08T08:... 5773 RBG_12345678 HostID 17 G25_request 4000019 6993 eventHandler[17] eventReport: G2...
2016-01-08T08:... 5772 REG_12345675 HostID 17 NfA a a unknown[0] G2SACK
\OTND 774 Unct INA7 DOr: AJZAEETE % ANONNA D 5D harfdl h cracl v
IE] Test Session Engine Iﬂ Test Sessions History Iﬂ Debug Console

You'll see that there are three distinct panels on the Test Session Engine tab of the CVT desktop:

Test Session Management — This panel contains controls that allow you to start, stop and configure the
Test Session. An active display shows the details of the active test case in a running test session, and a
View Results Icon appears on the right side of this panel when the test session concludes.

Test Session Errors — This panel reports test case errors as they occur. When the tester has to initiate an
action on the G2S Host, this panel switches to an instruction panel where that directive is displayed.

G2S Transcript — The standard G2S transcript used in all RadBlue tools to show the details of the G2S
traffic occurring during the session. Resizing the tool window automatically adjusts the size of this panel.

At the bottom of the desktop are three Navigation Tabs that allow you to quickly switch between the
Test Session Engine, the Test Session History (a history of saved test sessions), and the Debug Console.
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Configuring the CVT

CVT Transport Configuration — The first time you run the CVT, you need to tell it which IP address it
should listen on. This IP address must be routable to your host. To configure the IP address used by the
tool, simply open the Transport tab in the configuration screen, and select the appropriate address from
the drop down list of Bind To: addresses (the port numbers should remain unchanged):

Tools > Configure > Engine Options > Transport > Bind To

4 CVT Configuration

General- Transport | Configurable Values | Logging
IP Address & SOAP Port
Desktop Options Bind To : :192, 168, 100.59

@ SOAP Port @ 47101

Engine Options

Configure Test Session — Launch the Test Session Configuration screen by pressing the Configure Test
Session button in the Test Session Management section of the desktop:

Test Session Engine

Q:é Start @ stop O Configure Test Session "

Test Session Detail
Test Session ID :
TestCase D : Test Session Selection

|£2| Test Session Selection X

DES(EICEn: * ) Test Cases Test Session Template :  CVT-Testing i)
Step D : -1~ cabinet [1]
Description : Device Selection Mode © | All ~
TestMode : | All Test Cases “
CVT Error Results Device Filter :  Filter for RBG_12345678 | -
Test Case ID . Erro
How it Works B
Use the three filter controls to determine which cases will be tested by the CVT.
Test Session Template - Select a previously saved Test Session Template to run.

1) Test Session Template: Later, if you decide to exclude specific test cases from a test run, you can
create your own Test Session Template. To launch the Test Session Templates table, simply click the
Gear button next to the Test Session Template: field to get the following screen:

Test Session Templates

dd - ~ Active Test Session Template
< A o T SERAs AsE all-test-cases-selected. xml

Description | File Name | Schema Version
& Indude All Test Cases all-test-cases-selected. xml v2.1.0

a) When you Add a new Test Session Template file, you are prompted for the description and G2S
schema to use, and then the Modify Test Session Template screen launches. Selecting Edit, or
double-clicking a Test Session Template row will also launch this screen (see next page):

Confidential — Radical Blue Gaming, Inc. Page 6

X

Engine Options



radblue Getting Started with CVT-EGM

Meodify Test Session Template

Description :  |New Test Session Template
G283 Protocol Version : v1.1.0
Transport Version: w1.2.0

I_E| E' MNew Test Session Template [197] )
& (] [ cabinet [36] L Test Case: CB-COR-00001
= m B cor [34)
e o] This case verifies that the EGM does not accept commands from non-guest
- [] & CB-COR-00002 hosts.
- [] #2 CB-COR-00003
- [] & CB-COR-00004 Objective
- [] =4 CB-COR-00005
- [] 4 CB-COR-00008
-] &% CB-COR-00007
-----EECB-COR-DDDDB Requirements Under Test
[ #& c8-Cor-00009 * 185
[ &2 CB-COR-00010 * 363
- [] &4 CB-COR-00011
- [[] & CB-COR-00012 Test Type: QUICK
- [] 4 CB-COR-00013
- [] & CB-COR-00015 Criteria
- [] & CB-COR-00027
- [] & CB-COR-00029 ¢ Protocol: G25 1.1+ * Endpoint: EGM
-~ [] & CB-COR-00037 * G5A Class: cabinet * Required Hosts: 1+
- [] &4 CB-COR-00033
.. [ & CB-COR-00033 i

Verify that the EGM does not accept commands from non-guest hosts.

Cancel Sawve As

b) The Modify Test Session Template screen allows you to view / change the Description of the
test session template.

c) ATest Case tree control that you can expand, allows access to any level (Class, Functional
Group, or individual Test Case).

i) Selecting or deselecting a node affects all nodes beneath the node.

ii) Selecting the Test Case ID in the tree causes the Test Case Encyclopedia entry to appear in
the right side panel, replacing the default help text.

When all changes have been made, press the Save or Cancel button to save or reject the
changes.

d) If you've added or made changes to a file, you can change the Active Test Session Template file
by selecting the desired file in the list, and then pressing the Set As Active button.

NOTE: To return to a configuration where all test cases are available in the tool, simply select
the Template - All template file, and make it the active test session template.

2) Save the Test Session Configuration — When all configuration changes are complete, press the Save
button to save the changes and close the Test Session Configuration screen.
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Starting a Test Session

To start a CVT-EGM test session using the current configuration, simply press the Start button in the
Test Session Management section of the Test Session Engine panel:

cvT
Test Session Engine
@ Start 's_:g' Stop i O Configure Test Session

Test Session Detail
Test Session 1D :

At this point, the CVT-Host session takes over and executes all appropriate test cases for the Test
Session. If a test case needs some help, the program will pause, and a prompt will indicate what action
needs to be initiated on the EGM. If the CVT is waiting for a command to be sent, it will automatically
advance when the command is received. Alternately, True, False, and Skip buttons are provided to
indicate that the action has been done, has not been done, or can’t be done on the EGM under test.

Test Session Engine = 0 x

'9}_!' Start Q;g Stop ¥ Configure Test Session Instructing the user.

Test Session Detail
TestSessionID: 10
TestCage |D: CB-COR-00023
Description :  This case verifies that the host handles error responses to host cabinet requests.
Step 1D :  {023a2c9f-6903-4cBf-a35a-35f6f5 74377}
Description :  Instruct user to send setCabinetState command from the host,
I 10f57

Test Session Template :  All-Test-Cases-Selected. xml
Device ID: 17

User Interaction

& True

Send setCabinetState to device 17 (1 of 4). 8 False

# M Skip

ik
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Viewing the Test Session Results

When the test session has completed, a View Results button appears on the right side of the Test
Session Management panel:

Test Session Engine (LI

Q:g Start @ stop ’ i O Configure Test Session ]

Test Session Results \
Host URL :  http:f{127.0.0.1:31101/RGS fapi-services/G2SAPI  Test Cases Executed: 6 ]
TestSessionD: 10 Test Cases With Errors - 1 Hﬂﬂﬂ View Results

Test Session Template :  Include All Test Cases Test start datetime :  Thu Jun 11 14:25:55 PDT 2015
Test end dateitime :  Thu Jun 11 14:53:38 POT 2015

Clicking the View Results button causes the Test Session Results Screen to display

-

|£:| Test Session 10 @

Test Session Results [ B [ [BReports |

Template : Include All Test Cases Session Tag: |Session Tag
Softlware Version : CVT 11.90.0

TestSessionD: 10
You can add any comments that you would like in this area.

Start Date/Time :  Thu Jun 11 14:25:55 PDT 2015
They will be saved with the results, and will be displayed on any reports created

End DatefTime : Thulun 11 14:53:38POT 2015 | OMMENtS(E): by the tool.

Last Saved On: Thu Jun 11 14:59:02 PDT 2015

Results How it Works
Filter : :Show All -
(-4l CVT Exceptions [0]

=4 T:ast Session Summary [11]

Expand CVT Exceptions to view exceptions that occurred during testing. CVT
Exceptions tests that are run automatically,in the background. and are not tied to any
parficular test case or functional group. CVT Exceptions include checks for

= é:__%segzl?:]t L7 unexpected values and unknown namespaces. The number of exceptions in each

ES g‘ CB-COR-00022 [1] category appears in brackets.

i e @17 [1]
: - & CB-COR-00023 [8] Expand Test Session Summary to drill down by class. functional group and test case.
- G25_communications [4] Double-click any test case to view a transcript of the messages sent for that case.

Then, double-click any message in the transcript to view the message details.

You can change the displaved content - either all cases tested or only test cases with
errors - by toggling the Filter field directly above the Summary list. The number of
test cases displaved appears in brackets.

1) Inthe top right (green box) are two buttons that allow you to Save any changes you make on this
screen, or create any of the Reports that are available in the tool.

2) Inthe three fields in the orange box, you can enter the following information (which is stored with
the session results and once saved will display on the Detail, Summary, and Excel reports):

a) Session Tag (your id for this run),
b) Software Version (the version of Host Software being tested)
c¢) Comments about this test run that should be stored with the results

3) The Results Tree (blue box) can be expanded to see CVT Exceptions (anomalies detected during the
run) and the Test Session Results. If desired, the Filter selector can be toggled between Show All
results or Errors Only (typically the more useful choice). When a node in the tree is selected, the
“How It Works” panel transforms into a Results Table that shows details of each of the items.

Double click on a row in the test session results table to launch a transcript of relevant messages.
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Creating a Debug.zip File
If you run into any issues, or have any questions...

The Export Debug option lets you create a ZIP file containing all the files that the RadBlue support team
needs to troubleshoot product issues or to perform more detailed analysis in the RadBlue Analysis Suite
(RAS). The ZIP file includes data from the time the tool was started to the time you select the Export

Debug option.

File > Export Debug ...

A save dialog will prompt you for the location where you would like the debug file created. Click Save.

Attach the ZIP file to an email and send it to support@radblue.com.
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